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This document covers the process of reconciling attendance based on the quarterly leave collection during 
Cycle processing.  

Leave Collection 
 Leave is collected during Cycles 2, 5, 6, & 8.  

o Cycle 2 (Due October 15th) – pulls July 1st thru September 30th attendance records 
o Cycle 5 (Due February 15th) – pulls October 1st thru December 31st attendance 

records 
o Cycle 6 (Due April 15th) – pulls January 1st thru March 31st attendance records 
o Cycle 8 (Due July 31st) – pulls July 1st thru June 30th attendance records 

 
 Leave collection pulls all attendance records (Posted/Unposted) recorded with a Start Date 

OR an End Date that falls within the date range listed for the cycle.  
o To keep clean reconciliation records it is recommended to record two separate 

entries for any attendance items that cross months.  
 EX: Attendance needs to be recorded for 09/29/20XX-10/02/20XX 

• Create entry for 09/29/20XX-09/30/20XX 
• Create entry for 10/01/20XX-10/02/20XX 

 
 When collected, SIS sorts attendance records into eleven standard types of leave: 

o Sick 
o Personal 
o Vacation 
o Bereavement 
o School Business 
o Professional Development 

o Military 
o Jury 
o LWOP 
o Other 
o ADE Maternity (ONLY Pay 

Codes 980 & 981)
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Employee Leave - Check Location & Job Assignment 
 
• District-Wide Employees such as custodians, food service, bus drivers, superintendent, 

central office employees may all have 000 or ‘district-defined’ district-wide three-digit alpha-
numeric location code in check location. 

• All employees who work at the school level: teachers, school administrators, school 
secretaries, librarians, counselors, aides, nurses, etc. – check location must match the 
primary location where they work. 

• If the employee’s salary is required coding to the LEA level then the check location will have 
same requirement. 

• A Cycle validation error will occur for every school employee whose check location is not a 
valid LEA. That error will be programmed by ‘Job Assignment codes.’   

o Teachers do not have a job assignment code in eFinance from the official certified 
job code management system manual thus all teachers must have a valid LEA in 
check location.   

o All other employees in eFinance should have a job assignment code in eFinance. 
Each job code should come from the official certified and classified job code 
manuals.  
 https://adedata.arkansas.gov/jcms 

o Job codes requiring Valid LEA are listed on next page. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

https://adedata.arkansas.gov/jcms
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Valid LEA required for Check Location if employee has one of following job codes: 
 
CLASSIFIED Job Codes  
Nursing Positions 

454 – Nurse - LPN 
455 – Nurse - RN 
457 – Nurse - RNP 
458 – Nurse - APN 
459 – Nurse - APRN 
460 – Nurse - CNP 
461 – Nurse - CRNA 
462 – Nurse - CNS 
463 – Nurse - LPTN 
465 – Nurse - CNM 

Other Health & Support Roles 
464 – Physical Therapist (PT) 
502 – Library Media Clerk 

Instructional Support 
763 – Paraprofessional Instructional (non-Title I School) 
785 – ESOL Paraprofessional (providing LIEP srv to ELs) 
777 – Study Hall Monitor 

Apprenticeship & Residency 
765 – Registered Apprentice 
766 – One Year Resident 

 
 
 

Valid LEA requires CHECK LOCATION if the employee has one of the following job codes: 
 
CERTIFIED Job Codes  
School Administration 

2010 – Elementary School Principal 
2020 – Elementary School Assistant 
Principal 
2030 – Middle/Jr. High School Principal 
2040 – Middle/Jr. High School Assistant 
Principal 
2050 – High School Principal 
2060 – High School Assistant Principal 

Curriculum Supervision 
3020 – Curriculum Supervisor (Secondary) 
3030 – Curriculum Supervisor 
(Elementary) 

Library/Media Specialists 
5010 – Elementary Library/Media 
Specialist 
5020 – Middle/Jr. High Library/Media 
Specialist 
5030 – High School Library/Media 
Specialist 

Guidance Counselors 
6015 – Elementary Guidance Counselor 
6020 – Middle/Jr. High Guidance 
Counselor 
6030 – High School Guidance Counselor 

 

Instructional Leadership & Support 
7090 – Master Teacher (TAP) 
7100 – Coach/Lead Teacher/Instructional 
Facilitator (Math) 
7135 – Coach/Lead Teacher/Instructional 
Facilitator (Generalist; All Subjects) 

ESOL & Inclusion 
7144 – ESOL – Licensed Teacher, ESOL 
Endorsed 
7145 – Inclusion Teacher (Co-teaching 
model) 
7146 – ESOL – Licensed Teacher, Not 
ESOL Endorsed 

Special Education & Behavior Support 
7150 – Consulting/Indirect Special 
Education Teacher 
7160 – In-School Suspension Teacher 

Specialty Instruction 
7170 – Adaptive PE Teacher 

Mentorship & Career Development 
7400 – Journeyman 
7410 – Resident Mentor 
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1. Employee Check Location 
 

The employee Check Location field can be verified from the Employee Information page.  
 

Menu Path: Human Resources>Entry & Processing>Employee>Employee Information 
 
Search for and open desired employee screen. 
 
Select the Payroll tab.  
 
The Check Location field is the first available field on this tab.  

2. Employee Job Assignment 
 
The employee Job Assignment field can be verified from the Employee Information page.  
 
Menu Path: Human Resources>Entry & Processing>Employee>Employee Information 
 
Search for and open desired employee screen. 
 
Select Personnel Information from the top menu bar.  
 

 
Select Assignments from the dropdown list.  
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The screen will display similar to the following.  
 
Verify the data listed is valid and accurate.  
 

 
Note: For additional information regarding job assignments review the ‘Job Assignment 
Codes’ document on the apscn.org website.  
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Preparing to Reconcile Quarterly Attendance 

1. Attendance Report 
 
Menu Path: Human Resources>Entry & Processing>Attendance>Attendance Report 

1A. Enter Start and Stop Dates (same as used in cycle being reconciled)  
• Cycle 2 (Due October 15th) – pulls July 1st thru September 30th attendance 

records   
• Cycle 5 (Due February 15th) – pulls October 1st thru December 31st 

attendance records 
• Cycle 6 (Due April 15th) – pulls January 1st thru March 31st attendance 

records 
• Cycle 8 (Due July 31st) – pulls July 1st thru June 30th attendance records 

 
Below is the recommended date format to be used: 

• Start Date - >=MMDDYY 
• Stop Date - <=MMDDYY 

 
Click Accept. 
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1B. Enter Report Options 
• Status Type* - B-Both 
• Post Type* - B-Both Posted & Unposted 
• Sort Order* - Select preferred option  

o Recommend 5-Check Location/Name 
 
Click Accept.  

 
Example: Cycle 2 FY24 
 

 
 

Print window will appear – run to EXCEL 

 
Click OK. 



Arkansas Public School Computer Network 
eFinancePlus 20.11 Procedural Outline 

8 | P a g e  
 

Processing windows will appear.  
 

 
While report is processing will receive the following notification. 
 

 
The report will populate at the top of the homescreen. Click the file to open. 
 

 
 
The workbook will display similar to the following.  
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1C. Create a Pivot Table 
 
Select cell A1 on the excel spreadsheet. 
 
Select the Insert Tab from the menu bar.  
 
Click on the Pivot Table option. 

 
A screen similar to the following will display. 

 
Verify that the Table/Range values encompass the range of cells that should be included in the 
PivotTable.  

• The cell range listed in this field will be outlined with a dotted line on the worksheet for 
quick reference. 

 
PivotTable should be placed in a New Workbook. 
 
Click OK.  
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The screen will display similar to the following. 
 

 
Rename each tab by right-clicking on the tab and selecting the Rename option. 
 
After desired tab name has been keyed, hit the Enter key to maintain the change.  

 
• Rename the Sheet2 tab as PivotTable. 
• Rename the SPIDATA tab as Attendance Report.  



Arkansas Public School Computer Network 
eFinancePlus 20.11 Procedural Outline 

11 | P a g e  
 

Use the following setup to display the Pivot Table as shown in below example.  
 

• Drag the PAY CODE option to the COLUMNS field. 
• Drag the LOCATION option to the ROWS field. 
• Drag the LEAVE HOURS/DAYS option to the VALUES field. 

 

 
The Pivot Table will display similar to the following with this selection. 
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Note: Because the entire Pay Code column was included as a field in this Pivot Table all Pay 
Codes included in the Attendance Report pulled from eFinance will display in the Pivot Table. 
User will need to filter out any Pay Codes that will not be included in the Cycle Leave report.  
 
Select the filter for the PAY CODE (Column Labels) cell.  
 

• Filter out 094, 098, & 099 from PivotTable 
• Filter out 960-979 Range from PivotTable 
• Filter out 982-989 Range from PivotTable  

o DO NOT filter out Pay Codes 980 & 981. These are used to report ADE Maternity 
Leave. 

 
The table will automatically adjust the totals to exclude any values that have been filtered out.  
 

 
Note: User can update the ‘Row Labels’ (Cell A4) and ‘Column Labels’ (Cell B3) title fields in 
the Pivot Table to more easily recognize the displayed fields.  

• See below example where ‘Row Labels’ was adjusted to ‘Location’ and ‘Column 
Labels’ was adjusted to ‘Pay Code’. 
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1D. Define and Total Leave 
 
On the Attendance Report tab highlight and copy the Pay Code column.  
 
Paste the data on an empty column to the side.  
 

 
Verify the only data highlighted is the new Pay Code column.  
 
Go to the Data Tab at the top of the workbook.  
 
Select Remove Duplicates.  

 
 Verify data listed in the popup box is all that should be included in the removal process.  
 

 
 
Click OK. 
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A message will display detailing how many duplicates were removed.  
 

 
Click OK.  
 
With the new Pay Code column still highlighted select to ‘Sort A to Z’.  

 
In the column to the right of the new Pay Code column input Total as the column header.  
 
A SumIf function will need to be recorded in this column to sum the total number of Leave 
Hours/Days that are listed in the report for each Pay Code.  
 
The sumif function data is recorded with the following formula: 

 
With the understanding that: 

• Range – Is the range of cells to be evaluated 
• Criteria – Is the condition/criteria that defines which cells will be added 
• [Sum_Range] – Is the range of cells to be summed 

 
In the case of the example displayed above: 

• The range of cells will be the original Pay Code column – Column D 
• The criteria will be a specific cell in the new and adjusted Pay Code column – Ex: N2 
• The [sum_range] will be the Leave Hours/Days column – Column H 

 
This can be written as =sumif($D:$D,$N2,$H:$H) as is displayed below.  
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After this formula is recorded beside the first pay code to be totaled it can be dragged down to 
total all the pay codes listed in the new Pay Code column.  
 
Sum up the totals of the new Pay Code column and verify it matches the totals listed in the 
Leave Hours/Days column.  
 

• This can be done by highlighting the Leave Hours/Days column and matching the 
total of the new Pay Code column to the Sum that displays on the bottom right of the 
excel screen.  
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1E. Verify Pay Code Information 
 

Copy the totals calculated by Pay Code from the Attendance Report tab to the PivotTable tab 
for comparison against the rpt280 and the Pivot Table.  
 

• Note when pasting information to the PivotTable tab be sure to use the ‘Values’ paste 
option. The formula used to calculate leave totals will not copy over correctly to the new 
tab.  

 
• Exclude 094, 098, & 099 from Calculations 
• Exclude 960-979 Range from Calculations 
• Exclude 982-989 Range from Calculations 

o DO NOT filter out Pay Codes 980 & 981. These are used to report ADE Maternity 
Leave. 

 
In the example below, the 099 pay code has been excluded from the totals calculation as it is 
not included in the cycle attendance collection. 
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After totals are verified it will need to be determined what type of leave each Pay Code is.  
 
To do this go to the Pay Code reference table in Human Resources.  
 
Menu Path: Human Resources>Reference Tables>Payroll>Pay Codes 
 
The below screen will display. 

 
It is important to note that the rpt280 from Cycle defines the leave on the report from: 

1. The Pay Code 
2. The Pay Code Check Title Field 
3. The Pay Code Pay Type 

 
Search for the pay codes listed on the attendance report and note the Pay Code Title, Check 
Title, and Pay Type. 
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Make note of the Pay Code information beside the totals copied onto the Pivot Table tab from 
the Attendance Report tab.  
 
Below are how the Pay Codes are set up for the example in this document.  
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2. SIS rpt280  
 
The Employee Leave report (rpt280) takes multiple steps to determine how the attendance 
records are reported during cycle.  
 

1. It pulls the leave by Pay Code.  
2. It defines which category to place that leave according to the Check Title assigned to 

the Pay Code in the district database.  
o SIS sorts attendance records into eleven standard types of leave: 

 Sick 
 Personal 
 Vacation 
 Bereavement 
 School Business 
 Professional 

Development 

 Military 
 Jury 
 LWOP 
 Other 
 ADE Maternity (ONLY 

Pay Codes 980 & 981)

 
3. It breaks out the type of leave (hourly, daily, etc.) into separate pages on the report 

based upon the Pay Type assigned to that specific Pay Code.  
4. It will designate if it is Certified, Classified, or Teacher by Job Assignment and Check 

Location from the Employee Information page. 
 
 

2A. Pull the cycle Employee Leave Report (rpt280) from SIS.  
 

Menu Path: (UNCERTIFIED) SIS>Submit Data Tab>View Cycle Reports 
• Verify Cycle from dropdown menu 
• Select rpt280 Employee Leave Report 
• Print report to PDF 

 
 

Menu Path: (CERTIFIED) SIS>Certified Reports Tab 
• Verify Cycle from dropdown menu 
• Select rpt280 Employee Leave Report 
• Print report to PDF 
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The report will display similar to the following.  
• Note: if multiple Pay Types are used on the Attendance Pay Code records the report will 

separate the leave records out onto multiple pages.  
 The sum of the totals listed on rpt280 should match the total filtered leave that is 

listed on the Attendance Report and Pivot Table.  
 
The report for this example has two pages:  
• Page 1 is for Daily Pay Type records  
• Page 2 is for Hourly Pay Type records 

 

 

 
 

 
 



Arkansas Public School Computer Network 
eFinancePlus 20.11 Procedural Outline 

 

21 | P a g e  
 
 

Reconciling the Reports 

Compare Attendance Report/Pivot Table/rpt280 
 
All three reports (rpt280, Attendance Report, and Pivot Table) will be used for different purposes 
when reconciling.  
 

1. The rpt280 and the Attendance Report filtered totals will be compared against one 
another to verify the breakdown of attendance records by Pay Type reported during the 
cycle.  

2. The rpt280 and Pivot Table will be compared against one another to verify the leave 
totals by district Location. 

3. The rpt280, Pivot Table, and Attendance Report grand totals will be compared to verify 
all data reconciles.  

1. Compare rpt280 and Attendance Report 
 
To reconcile the Attendance Report to the rpt280 the pay codes will need to be broken down by 
a couple different factors.  
 

1. Determine which rpt280 leave type best suits the Pay Code Check Title on the 
Attendance Report.  

2. Separate the different Pay Types for reconciliation purposes.  
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If there are multiple Pay Codes that are tied to a single leave type from the rpt280 then sum 
those values together to reconcile against the SIS report.  

• EX: Hourly Pay Codes 131, 132, 133, 134, and 138 from above table tie back to the Sick 
leave type on the Hourly Employee Leave Report (page 2 of rpt280). To reconcile these 
values will need to add the totals for these three Pay Codes from the Attendance Report 
to verify they match the Hourly Sick amount on the rpt280. 

 
Notice that in the above example when comparing the Daily rpt280 totals to the Daily Pay Type 
totals from the Attendance Report it can be found that there is a variance of three (3) Daily units 
of Sick Leave.  

• The Attendance Report Pay Code total shows 213.5 units of Sick Leave with the D – 
Daily Pay Type.  

• The rpt280 shows a total of 216.5 units of Daily Sick Leave. 
 
The next step to finding the cause of this variance is to determine the location in which the 
variance occurred.  
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2. Compare rpt280 and Pivot Table 
 

To reconcile the Pivot Table to the rpt280 by Location the leave totals on the Pivot Table can be 
recognized by Pay Code Check Title, Pay Type, and it’s rpt280 counterpart.  
 
Below is an example of how this may be done.  

• The SIS rpt280 column titles associated with the pay codes were manually input in Row 
1 above the Pivot Table.  

• The Check Title associated with the pay codes were manually input in Row 2 above the 
Pivot Table.  

• The Pay Type (Daily or Hourly) associated with the pay codes were manually input into 
Row 3 above the Pivot Table. 

 
Recall from the Attendance Report/rpt280 reconciliation that there was a three (3) Day variance 
of Daily Sick Leave.  

 
When comparing the Pivot Table to the rpt280 it can be seen that the Sick Leave variance is 
caused by entries made to the Elementary School (043) location.  
 

• Elementary School (043) Location 
o The Pivot Table shows a total of 113.5 Days of Sick leave.  
o The rpt280 shows a total of 116.5 Days of Sick Leave. 
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3. Compare rpt280, Pivot Table and Attendance Report Grand Totals 
 

The final reconciliation that needs to be completed is between all three reports: 
• Rpt280 
• Pivot Table 
• Attendance Report 

 

Note that when reconciling with the rpt280 all totals for all Pay Type units will need to be 
included (Daily, Hourly, etc.) in the grand total.  

• In the above example the Grand Total for leave would be: 
Total Days  307.5000 
Total Hours  753.5800 
Grand Total  1061.0800 
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With the above examples it can be seen that the: 

• Pivot Table and Attendance Report reconcile 
• Pivot Table and rpt280 DO NOT reconcile 
• Attendance Report and rpt280 DO NOT reconcile 

 
If the reports do not reconcile the variance will need to be researched. In most cases a variance 
is caused by attendance records that are entered crossing periods/quarters.  
 
Remember, the quarterly leave collection pulls all attendance records (Posted and Unposted) 
recorded with a Start Date OR an End Date that falls within the date range listed for the cycle. 

 

• To keep clean reconciliation records it is recommended to record two separate 
entries for any attendance items that cross months.  

o EX: Attendance needs to be recorded for 09/29/20XX-10/02/20XX 
 Create entry for 09/29/20XX-09/30/20XX 
 Create entry for 10/01/20XX-10/02/20XX 

 

• Leave is collected during Cycles 2, 5, 6, & 8.  
o Cycle 2 (Due October 15th) – pulls July 1st thru September 30th attendance 

records 
o Cycle 5 (Due February 15th) – pulls October 1st thru December 31st attendance 

records 
o Cycle 6 (Due April 15th) – pulls January 1st thru March 31st attendance records 
o Cycle 8 (Due July 31st) – pulls July 1st thru June 30th attendance records 
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Finding the Variance 
 
After variances have been determined by leave type and location they can be found by 
reviewing the SIS emp_leave table associated with the Cycle.  
 
Menu Path: SIS>Submit Data Tab>View SIS Tables>Select emp_leave table 
 
Select to send to Excel. 
 
The table will display similar to the following.  

 

Once exported to Excel the table can be manipulated to determine the cause of the variance.  
 
While on the Home tab select cell A1.  
 
Select the Sort & Filter option dropdown menu.  
 
Select the Filter option.  

 
There are a few columns that are worth noting for filters and searching.  

• Emp_location (Column H) – Employee Check Location 
• Leave_unit (Column K) – Pay Code Pay Type 
• Pay_code (Column O) – Pay Code Number 
• Pay_desc (Column P) – Pay Code Check Title 
• Start_date (Column Q) – Attendance entry Start Date 
• Stop_date (Column R) – Attendance entry Stop Date 

 
To quickly find this variance of the example in this document the following selections can be 
made on the emp_leave table.  
 
Filter: 

• Emp_location (Column H) - to show only the Elementary School location code 043 
• Leave_unit (Column K) – to show only D for Daily attendance records 
• Pay_code (Column O) – to show only Pay Codes 110 & 125 where variance occurred 

OR 
• Pay_desc (Column P) – to show only the Pay Code Check Titles including ‘Sick’ 



Arkansas Public School Computer Network 
eFinancePlus 20.11 Procedural Outline 

 

27 | P a g e  
 
 

Once the filters have been set the next step would be to search for any attendance records that 
fall outside of the quarter attendance collection date range.  
 
Because this example is pulled for FY24 Cycle 2 the below search would be valid.  
 

• Start_date – Search for anything with a start date before July 1. 
• Stop_date – Search for anything with a stop date after September 30. 

o The stop date filter search rendered the following results.  

 
It can be seen that the cause of this variance is due to the stop date falling outside of the 
quarterly collection period. Because the entry has attendance dates that are within the collection 
period the entire attendance entry is being included in the SIS attendance total.  
 
Recall that the Attendance Report was pulled from eFinance with quarterly date specific criteria: 
only dates that start on or after (>=) 07/01/2023 and end on or before (<=) 09/30/2023 for this 
example. 
 
Note: In order to not have variances like this cause issue in future reconciliations it is 
recommended to split attendance entries that cross months into at least two entries: one for 
each month affected.  
 

 EX: Attendance needs to be recorded for 09/29/20XX-10/02/20XX 
• Create entry for 09/29/20XX-09/30/20XX 
• Create entry for 10/01/20XX-10/02/20XX 
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Notes/Reminders: 
• When recording attendance entries, either manually or by import, never disable the 

calendar validation. The calendar validation verifies the attendance entry start and stop 
dates against the calendar associated to the employee pay rate screen.  

o Disabling the calendar validation will:  
 Allow attendance entries to be made to dates that are outside of the 

employee calendar, up to and including dates outside of the current fiscal 
year.  

 Stop the system from auto-docking with docking code 099 – Automatic 
System Docking. If a situation arises where the system should auto-dock, 
it will create a 099 LWOP entry in the attendance page. However, there 
will be no docking displayed on the timecard when attendance is posted 
to payroll. This will require manual adjustments to the timecard to correct.   

o Can determine if the calendar was disabled when the attendance entry was 
created by reviewing the attendance entry Validation column. If the calendar was 
disabled when the entry was created this field will reflect that.  
 If it is found, while an attendance entry is unposted, that it was created 

when the calendar validation was not enabled then can delete the entry 
and create it with the validation being enabled.  

 If it is found, after an attendance entry is posted, that it was created when 
the calendar validation was not enabled then will need to review the 
attendance entry information. Verify that all dates listed fall within the 
working days in the employee calendar for the current fiscal year (i.e. no 
holidays, non-work weekdays, etc.). If the posted entry created a system 
docking line, the employee timecard will need to be reviewed and 
manually adjust/verify wages are docked as needed.  

• It may also be necessary to reverse the attendance entry using 
the same information as was listed on the original and the 
recreate a corrected entry with the right information. 
 

Menu Path: Human Resources>Entry & Processing>Employee>Attendance 


	Leave Collection
	Employee Leave - Check Location & Job Assignment
	1. Employee Check Location
	2. Employee Job Assignment

	Preparing to Reconcile Quarterly Attendance
	1. Attendance Report
	1A. Enter Start and Stop Dates (same as used in cycle being reconciled)
	1B. Enter Report Options
	1C. Create a Pivot Table
	1D. Define and Total Leave
	1E. Verify Pay Code Information

	2. SIS rpt280
	2A. Pull the cycle Employee Leave Report (rpt280) from SIS.


	Reconciling the Reports
	Compare Attendance Report/Pivot Table/rpt280
	1. Compare rpt280 and Attendance Report
	2. Compare rpt280 and Pivot Table
	3. Compare rpt280, Pivot Table and Attendance Report Grand Totals


	Finding the Variance
	Notes/Reminders:


